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Ready to go on a GeoSafari? Get set for a spectacular learning
adventure that will bring the whole family together. 

Each of the four GeoSafari Multimedia titles offers a unique
learning experience that's fun and challenging for kids of all
ages. Look into the past with GeoSafari History or explore
today's world with GeoSafari Geography, GeoSafari Science
brings you the wonders of nature and technology, and
GeoSafari Animals will introduce you to some fascinating
wildlife. 

GeoSafari is easy to use. Just follow the Start-up instructions
on page 2 of this guide. As soon as your program is installed our
narrator, Richie Havens, will tell you everything you need to
know to get started on your first game--right away.

Parents! GeoSafari is a game for the whole family, but it also
offers advantages for kids in school. To help you make the most
of GeoSafari with your child, we've included Parents' Pages on
pages 23-28 of this guide. You'll also find additional "GeoNotes
to Parents" highlighted throughout that give helpful tips and
information. 

Welcome to 
GeoSafari Multimedia!

Welcome to 
GeoSafari Multimedia!
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Start-up
Instructions

The first time you play GeoSafari, follow the set-up instructions. This will ensure
that all the software necessary to run GeoSafari video & audio has been installed.
After that, simply follow the start-up instructions every time you play GeoSafari.

Important: Keep the GeoSafari disc in your 
CD-ROM drive during all game play.

Windows(R) Set-up Instructions
1. Insert the GeoSafari disc into the CD-ROM drive. Choose START and then 

RUN. Before installing the software, make sure that there are no other 
programs running.

2. In the command line box, type D:\SETUP and click on OK. (If your 
CD-ROM drive is not drive D, type the appropriate letter.)

3. Follow the on-screen prompts until the installation for GeoSafari and
QuickTimeTM is complete.

4. When the installation is complete, exit Windows(R) and restart your 
computer. When the machine is ready, continue with the start-up 
instructions.

Windows(R) Start-up Instructions
1. Insert the GeoSafari disc into the CD-ROM drive. 
2. Click Start, select Programs, select GeoSafari and click on the Geography, 

History, Science or Animals icon.
Macintosh Set-up Instructions
1. Insert the GeoSafari disc into the CD-ROM drive. Before installing the 

software, make sure that there are no other programs running.
2. Double-click on the GeoSafari disc icon. This will open the disc and show an

icon for the GeoSafari Installer. Double-click on the icon to start the 
installation.

3. Follow the on-screen prompts until the installation for GeoSafari and
QuickTimeTM is complete. 

4. When the installation is complete, you will be prompted to restart your 
computer. When the machine is ready, continue with the start-up 
instructions.

Macintosh Start-up Instructions
1. Insert the GeoSafari disc into the CD-ROM drive. Find your GeoSafari folder 

on the hard disk and open it.
2. Double-click on the Geography, History, Science or Animals icon in the

GeoSafari folder. 

If you need help, call (310) 884-2000 and ask for Software Technical Support.



Learning Your Way 
Around GeoSafari

Learning Your Way 
Around GeoSafari 

GeoSafari is so easy to use you probably won't need this page. But if you do,
remember, the Options button   is a good way to move around
the game.  When you click on Options, you can . . .

Meet GeoSafari's creators.

Give younger players a head start in their scores.

Change the time you have to answer questions. 

Learn more about the subjects covered in the games.

View your Awards Case.

Choose to play Takeover or Free-for-All games.

Pick a new game or restart the one you're playing. 

Change names or number of players, or quit GeoSafari.

Replay questions you missed in a game. 

Some options are not available during a game and can only be used before
and/or after a game. If an Options button is grayed out, you'll know it isn't
active at that time. 

3
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GeoSafari
Game Rules

- GeoSafari can be played by 1, 2, 3 or 4 players--or up to 4 teams.
- This GeoSafari disc contains 15 different games.
- Each game has up to 25 questions. In a standard game, you get 3

chances to  answer each question correctly. 
-A correct answer on the first try earns 3 points. 
-A correct answer on the second try earns 2 points.
-A correct answer on the third try is worth 1 point. 

- If you miss a question on the third try--or run out of time--GeoSafari
tells you the correct answer, but you receive no points for that turn and
the game moves on to the next question. Points are added up next to
your name on the screen.

- The number of questions you have left is shown on the left-hand side
of the screen.

A Perfect Score Game!
If you answer every question in a game correctly on the first try, you'll
earn a perfect score, receive a personalized fireworks
display and a gold medal. 
(See pages 5-6 for more information on
earning medals and your trophy.)

There are some special

games just for 2 players or

2 teams. See pages 12-14.
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Earn
GeoSafari Awards

. . .  and watch your personal Awards
Case fill up with glittering prizes! 
Here's how to go for the gold:

Earning Medals 
When you sign on for a 1-player
game, you'll automatically be assigned a
personal Awards Case. Your case holds 15
medals.

You'll earn a medal when you get a per-
fect score in a 1-player game. (That
means you answered all of the questions
correctly on the first try.)

Every time you earn a medal, it will be
placed in your Awards Case. You can visit
your awards any time you like.

Every time you earn a medal you'll also
earn an Awards Certificate. See page 21
for printing  instructions.

Meet this Indonesian 
girl in the 

World Greetings
geography game.

And when the 
Medal Case is filled, 

you'll earn a beautiful
golden trophy! 

11



EarningaTrophy
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EarningaTrophy

Earn all 15 medals and you'll receive your GeoSafari Trophy.
This trophy will be permanently displayed in your Awards Case.
When you earn your trophy you'll also receive a special Trophy
Certificate. See page 22 for printing instructions.

Visit Your Awards Case!
You can visit your personal Awards Case any time you want.
Just sign into GeoSafari under your Single Player Name (the
name that your scores are recorded under) and click on
Options and then on the Awards button.

Help your child get 
started filling his or her
Awards Case right away. 



GeoSafari records "best times"
for all 1-player perfect-score
games. Whoever has the best
time in a game gets to keep a
red "Best Time" Ribbon on that
medal in his or her Awards Case. 

But that red ribbon is always up
for grabs! Beat another player's
best time and take the ribbon
away to your own Awards Case--
until it's taken away again!

Miss a question when 
playing for time?

"Best times" are recorded only
for perfect-score games. If you
miss a question on the first try
during a 1-player game, the
timer will immediately disap-
pear. You can continue your
game, but you're out of the run-
ning for a Best-Time Ribbon--
until you try again!
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Here's how to win a 
Best Time Ribbon:

1. Whenever you start a 1-player game, a
special timer will appear under your
name. You'll also see the best time
ever earned for that game printed on
the lower portion of the game screen.
If you want to "beat the clock"--and go
for a ribbon--this is the time you're
trying to beat.

2. As you play,  your timer will add up the
seconds it takes you to answer each
question. Your goal: Beat the time
shown on the screen!

Beat the Clock and 
Collect Best Time

Ribbons

22

TIMER

The time
to beat



GeoSafari History Games
The First Americans--Native American artifacts.

Armaments on Land--From the long bow to nuclear weapons.
Great Inventions--Innovations that changed our lives forever.

Armaments at Sea--Sea weaponry that turned the tide in battle.
Great Leaders--Kings, queens, conquerors and heroes.

Great Artists--The GeoSafari Art Gallery.
Arms & Armor--Battle gear from the days of brave knights & fair ladies.

Great Civilizations--The origins of our world's cultures.
Great Writers--Words that endure the ages.

Who Wore It?--Who was wearing what and when.
Great Disasters--Horrifying episodes in history.

Decades in Review--Top events of the 50s, 60s, 70s and 80s.
U.S. Presidents--Headline happenings in U.S. history.

World War II--People, places & events of the deadliest war ever. 
Who Said That?--Famous quotes from famous folks.

GeoSafari History Games
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Try All the Games!

33 Your GeoSafari CD-Rom
includes 15 great games.
You might want to try out
other GeoSafari CD-Rom
titles, too. They're available
at a store near you.

GeoSafari Geography Games
USA Attractions--A photo journey across the United States.

World Landmarks--Your whirlwind tour of the world's most famous sights.
Canada--The provinces & capitals of Canada.

USA States 1--25 of the 50 USA states.
USA States 2--The other 25!

USA Capitals 1--USA  state capitals.
USA Capitals 2--And here's the other half!

Middle America--From Mexico to Panama--a great trip!
South America--Can you identify all 12 countries?

Europe--Russia is the largest country . . . what are the rest?
Africa--Featuring 25 African countries.

Asia--From tiny Singapore to immense China.
World Greetings--Say hello to children from around the world.

World Flags--Colorful flags from 20 countries.
World Currencies--Money makes the world go 'round. Check it out!

GeoSafari Geography Games
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GeoSafari ANIMALS Games
GeoSafari Dog Show--What's your pick for Best in Show?

Animal Hall of Fame--Top performers in the animal world.
Micro Mysteries--Strange things come in small packages.
Animals Sound Off!--Identify animals by their sounds.

Horse Round-up--Saddle up for a great ride.
Animal Eye-D--Can you ID these animals?
Animal Tracks--A back-country adventure.
Name That Bird Call--A real "tweet" game.

Weird World of Animals--Odd but true!
Endangered Animals--The real stories.
Animal Art Gallery--Tour the museum.
Reptiles--A cold-blooded competition.
Whale Watch--This is the BIG game.
Shark!--Sink your teeth into this one.

Skulls--More than meets the eye.

GeoSafari ANIMALS Games

GeoSafari Science Games
Our Solar System--A comet's eye view of Earth's neighbors.

Trees--Don't "leave" this one out!
Flower Families--Beautiful blossoms from around the world.

The Human Skeleton-- From the cranium to the tarsals!
The Bee--A real honey of a game.

Amazing Inventions--How did they do it? Find out here!
The Weather--And now . . .the GeoSafari Weather Report!

Rocks & Minerals--Glittering treasures from inside the earth.
Insect Defenses--They're small but they take care of themselves!

History of Aircraft--Aviation's greatest achievements.
Exploring Space--Great moments from the Space Race. 

Dinosaur Details--Who's who in the dino world.
Volcano!--An explosive journey inside a volcano.

Animal Classes--Mammal, bird, fish, reptile or amphibian?
Earth's Extremes--Hottest to coldest. Largest to smallest. And more.

GeoSafari Science Games



Take the 
GeoChallenge!

This is the tough one! In the
GeoChallenge we'll create a brand-
new game made up of questions
taken from each of your 15
GeoSafari games. You'll never
know what's coming up next.

In standard games, the rules are
explained before play begins.
Because GeoChallenge
games are created from
many different games,
there may not be a full
explanation of how to play
each question. Players will
have a better understanding of
GeoChallenge games if they
become familiar with the standard
games first.

10

Ready for the ultimate 
GeoSafari Adventure? 

Hang on. With a 
GeoChallenge, it's never 
the same game twice!

44
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Here's how to set up a GeoChallenge game:

On the game menu click on "GeoChallenge." 
GeoSafari will begin putting together your 

customized game. 

Note: Because GeoChallenge games are never
the same, scores aren't recorded, medals
aren't earned, and best times are not kept.



Playing with 2 players or
2 teams? GeoSafari has 3
different ways to play!

1. Standard is the way
GeoSafari is normal-
ly played.

2. Takeover lets you
"take over" the other
player's question if
he or she gets it
wrong.

3. In Free-for-All the
questions go to the
player who "taps in"
first.

You can change 2-player
game modes by clicking
on Options, then 2-
Player Options. On
pages 12-14 we'll show
you how to set up and
play Takeover and Free-
for-All.

"John, 
your tap-in
key is 9."

12

Meet Will Rogers and 
John Paul Jones in the 

Who Said That?
history game.

55
Go for 2-Player 

Competition

Free-for-All
What's a Free-for-All Game?

It's a game just for 2 players or 2
teams.

In Free-for-All, each question is up for
grabs! When you start a Free-for-All
game session, each player will be
assigned a special tap-in key on the
keyboard.

The player whose name appears on top
always uses the number 1 key to tap
in. The second player's tap-in key is
number 9.

After a question is given, the
player or the team who "taps in"
first gets to answer--for 3 points.
But watch out! If you tap in and are
wrong, you'll lose 3 points. Your oppo-
nent can then tap in and give the
question a try. If correct, he or she 
gets 2 points. If incorrect, 
2 points are lost.

"Will, 
your tap-in
key is 1."



Here's how to set up a Free-for-All game:

1.Once 2 players or 2 teams have selected 
their names--but before a game starts--
click on Options, then click on 2-Player 
Options. 

You'll see this menu:

2.Click on the Free-for-All button. 
(It will light up yellow, letting you know 
that you've changed the game format.) 

3.The Free-for-All "tap-in" timer will 
appear on the screen. (GeoSafari 
automatically gives you 45 seconds 
for "tapping in.")

Note: If you want to change this time in 
your  Free-for-All game, use  the "up" or 
"down" arrows on this timer. 

4.Click on Back to Game and you're all set.

Remember: Until you make a change, every 2-player or 2-team
game you play in this GeoSafari session will be a Free-for-All
game.

Are you sure you've got the answer? 

Once you tap in, you have only 7 seconds to

click on the right answer. If you run out of

time, you lose 3 points and your opponent
gets a chance to tap in.

13



TakeoverTakeover
What's a Takeover Game?
Like Free-for-All, it's a game just for 2 players or 2 teams. In a Takeover game each
player or team gets only one chance to answer a question correctly and earn 3
points. But watch out!  If the question is answered incorrectly,  the other player or
team "takes over" and can earn 2 points for the right answer.

Here's how to set up a Takeover game:
1.Once 2 players or 2 teams have selected 

their names--but before a game starts--
click on Options, then click on 
2-Player Options. 

You'll see this menu:
2.Click on the Takeover button. It will 

light up yellow, letting you know that 
you've changed the game format.

3.Click on Back to Game and you're 
all set.

Until you make a change, every 2-player 
or 2-team game you play in this GeoSafari 
session will be a Takeover game.

14

Pay attention to your 
opponent's questions! 
In a Takeover game, 

those questions might 
soon be yours!

This Viking warrior is one of 20 
historical characters you'll meet in the

Who Wore It? history game.



Retry Your Missed
Questions

Whenever you finish a 1-player game
you'll have the chance to replay any
questions you missed. 

Here's what to do:
1.At the end of a game, the

Options menu  will auto-
matically appear on your
screen.

2. Click on the Retry Questions
button.

3. In just a moment, GeoSafari will
replay the questions you missed
during the game. 

Remember: "Retry" questions aren't
scored--and you can't earn a medal if
you get them all correct--but it's a
great way to make sure you get that
medal next time around!

15

The "Retry Questions" option
is great for helping kids learn
those questions that they find
most difficult. 

You can meet this Argentine
boy, and his friends, in the

World Greetings 
geography game. 

This is a great way 
to brush up on the 

toughest questions, and 
get a better score next 

time around!

66



Adjust the 
Answer Clock Time

When you play GeoSafari, you're
automatically given 45 seconds to
answer each question. Some play-
ers may want more time, some
may want less.

Here's how to adjust a 
player's answer clock time:

1.Click on Options before a game
begins (or even during a game).

2. Then click on the Adjust Game
Time button.

3.Now click on either the "up" or
"down" arrow to change  the
number of seconds you want for
answering questions. When you
return to game play, this will be
the number of seconds the play-
er has to answer a question.

4.Adjusting the timer does not
affect your ability to earn
medals. A perfect score is a per-
fect score--regardless of the time
set on the clock.

16
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Give Bonus Points

Sometimes less experienced players
need a little help when competing with
more experienced players. When more
than one person is playing, you can
give another player a head start by giv-
ing him or her some Bonus Points to
make the game more even. The maxi-
mum number of bonus points any
player may receive is 20.

Here's how to give 
bonus points:

1.After all players have chosen names,
but before you actually begin a
game, click on Options and then
the Adjust Bonus button.  

2.You'll see a listing of all
players. Click on the up
arrow to add points for
any  player that you wish.

17

You can
individualize GeoSafari

games for all ages and all
levels of players . . . and 
give younger players 

a head start!

88

This is a great way to make family
GeoSafari games more fun and
more fair. Up to 4 players can play,
and you can adjust bonus points for
any or all players.
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Use the Same Name 
or Nickname Each 

Time You Play

It's fun to hear yourself called by dif-
ferent names or nicknames during a
game, but if you want to collect
medals and a trophy, use the same
name each time you play. Every time
you earn a perfect score, your medal
or Best Time Ribbon will be placed in
your Awards Case under the name
you are using.  

In multiple-player games, scores
aren't recorded and medals and the
trophy aren't earned. So, choose any
name or nickname you want! You can
be Blondie during one game and
Avenger in another. And if you've ever
wanted a different first name, here's
your chance to try it on. Have fun with
nicknames and names during multi-
ple-player games.

Previous Players

Have fun with 

nicknames and
names!

99



Visit the GeoSafari
Glossary

The Glossary contains an entry for every
one of the questions in all of the 15
games on your CD-ROM. To visit the
Glossary, first click on Options, then on
the Glossary button. Now just select a
game name and you'll see a menu of
everything that's included for that game.
Click on the title tab at the top of the
menu to return to the complete list of
games.

19

Don't forget the GeoSafari
Glossary when it's report time
at school.  See page 22 for
printing instructions.

Click here to
return to the list

of games

1100
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Check Out the 
GeoBytes

What's a GeoByte?
Every time you get a correct answer during a
GeoSafari game, an extra fact called a GeoByte
will appear in the box at the lower part of the
screen. 

GeoSafari has over a thousand of these fun fac-
toids--and you'll never know which one will pop
up next.  Take time to read them. You'll be sur-
prised at what you'll learn!

11111111
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Print!

Printing a Medal Certificate:
When you win a medal, you may
want to print out a certificate cele-
brating your achievement right
away. You can also print the certifi-
cate in a future session of play:
Just make sure you're playing in
one-player mode and using the
same name under which you
earned the medal.

1. Click on Awards in the
Options menu. Your Awards
Case will display all the
medals you have earned.

2. Click on Print Certificate.
3. Click on the medal for which

you would like to print a cer-
tificate.

4. Your certificate will be dis-
played. If you want your name
to appear just as it does on
the screen, click Print. 

5. If you want your certificate to
be printed with a different
name, or if you would like to
add your last name, click
Change Name. Type in your
name as you would like it to
appear on the certificate,
then click OK. Your certifi-
cate will be displayed with the
new name. Click Print.

1122
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Printing a Trophy Certificate
Earning a GeoSafari trophy by scoring 100% on all fifteen games is
quite an accomplishment. Follow these steps to print your special tro-
phy certificate. (Make sure you're in the one-player mode using the
name under which you earned your trophy.)
1. Click on Awards in the Options menu.
2. Click Trophy.
3. Click Print Certificate.
4. Your trophy certificate will be displayed. If you want your name to

appear just as it does on the screen, click Print.
5. If you would like your certificate to be printed with a different name,

click Change Name. Type in your name as you would like it to
appear, then click OK. Your certificate will be displayed with the
new name. Click Print.

Printing from the Glossary
The GeoSafari Glossary includes lots of valuable information. For easy
reference, it's simple to print a page from the glossary.
1. Click Glossary in the Options menu.
2. Click on the game title.
3. Click on the entry you want to print.
4. Click Print.
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Here are some things you can do 
to help your child make the 

most of GeoSafari:

1. Help your child experience success right away!
One of the most popular rewards in GeoSafari is the personal-
ized fireworks "celebration" a player is treated to at the end of a
perfect-score game. It's a dazzling surprise and a great motiva-
tor for earning perfect scores in other games.

It's important then to help your child experience the full
GeoSafari "star treatment" as soon as possible. For this reason,
we suggest you guide your child toward specific games that will
be easier for him or her to master. What's easier? Probably
those subjects that reflect your child's own strong interests.

Parents' PagesParents' Pages
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2. Praise your
child's success.

Kids love to share their successes with the people that matter most in
their lives--their parents. GeoSafari offers many opportunities to let
your child know how much you value learning--and his or her accom-
plishments.
Here are some things you can do:
- Ask to see your child's Awards Case.

Give your child the chance to "show off" his or her prizes. Watching
the Awards Case fill up is a great incentive for further achievement.

- Praise your child during a game.
The best opportunity to shower your child with genuine praise  is
while a game is going on. Your praise will be immediate and 
specific, and therefore most meaningful. You'll have to compete with
Richie Havens, our ever-encouraging narrator, but that's just fine. No
child can ever hear too many words of praise.

- Talk to your child about games that he or she especially likes.
GeoSafari's broad range of subjects guarantees that many of your
child's favorite topics will be covered. 

Fourteen medals,
Jason. You've

almost earned your
trophy. Way to go!

Parents' PagesParents' Pages



3. Visit the GeoSafari Glossary together.
Browse through the Glossary together to show your child
the range of information available. Point out that
GeoSafari can also be a helpful resource for school
reports. There's an entry for every GeoSafari question--
and that covers a lot of ground.

25
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4. Encourage your child to go for Best Time Ribbons.
Get some friendly family competition going--and help keep your child
brushed up on what he or she has learned. Once your child has
earned a medal, keep the Best Time Ribbon moving from one player
to another. 

5. Make GeoSafari time family time.
GeoSafari's variety of games makes it perfect for family play and fam-
ily discussion. Everyone benefits. The very nature of GeoSafari game
play encourages spirited conversation and lively competition.  Your
child will be learning and the family will be having fun--together.

6. Use GeoSafari to help with schoolwork.
GeoSafari's broad range of topics will come in handy when your child
needs to review specific subjects for school or write a report. Use the
print function to make copies of Glossary entries. (See page 22 for
instructions.)

26
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Printing GeoSafari
Activity Sheets

Printing GeoSafari
Activity Sheets

Your Platinum Edition GeoSafari includes special worksheets with
puzzles, word games, and other activities that reinforce and extend the
knowledge and skills learned in the games. Answer keys appear at the
end of the activity sheets.

Follow these instructions to view and print 
out the GeoSafari Activity Sheets.

Macintosh Users

1. Locate the GeoSafari folder on your hard disk and
double-click on it.

2. For information on how to use the activity sheets in the
classroom or home, double-click on the Activity Sheets -
Read Me icon.

3. To install Acrobat Reader, double-click on the CD-ROM
to open it. Then double-click on the Install Acrobat
Reader icon. Follow the on-screen instructions.

4. To view the activities, double-click on the Activity
Sheets pencil icon. Activity sheets for all the games are
included in this document. Use the scroll bar to turn
pages.

5. To print activity sheets, select Print from the File
menu, choose which pages you want to print, and
click on the button labeled Print.
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Windows Users

1. Click Start, then highlight Programs.
2. Highlight GeoSafari.
3. For information on how to use the activity sheets in the classroom

or home, click on the Activity Sheets - Read Me icon.
4. To view the activities, click on the Activity Sheets pencil icon.

Activity sheets for all the games are included in this document. Use
the scroll bar to turn pages.

5. To print activity sheets, select Print from the File menu, choose
which pages you want to print, and click OK.
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